Description

Simple Building
Slab Design

For LUSAS version: 20.0

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): RC Slab Design

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description
Four panels of a concrete slab Line Support
supported by a wall, columns and a 5
lift shaft are to be analysed, with Panel A Panel B
reinforcement areas computed for
bending moment only. Shear and Slab Thickness 200mm 6m
: C te 40 N/mm?
dlsp_lacement checks need to be Ston! 460 NITm?
carried out separately. The geometry Columns
of the slab is as shown. L e T~
[J L L] 4
The slab is subjected to self-weight Panel C Panel D
and a live load.
\ .
The units of the analysis are N, m, 21 ;E];pons o
kg, s, C throughout.
o
Objective [] ] T
U To produce utilisation plots } 6m ‘F 6m }

under ultimate loads and
check the locations of cracking under service loads
Keywords

2D, Plate Elements, Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel
Area, Load Combinations, Smart Combinations, SLS, ULS, Beneficial, Adverse, Cracking




&

Modelling

Simple Building Slab Design

Associated Files
Associated files can be downloaded from the user area of the LUSAS website.

O slab_design_modelling.lvb carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

o Enter the file name as Slab_Design

Enter a file path for the working folder.

e Set the Analysis type to be Structural

e Set the Analysis Category to be 2D Grillage/Plate

e Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Select the Startup template None from those available in the drop-down list.
e Enter the title as Slab Desigh Example

e Leave Layout grid set to None and click the OK button.

Note. The Analysis category determines which elements will be available for
modelling. Here we are only interested in the out-of-plane bending effects in a flat slab
and therefore we can approximate this behaviour with 2D plate elements.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.




| Geometry
| Surface >
| By Coords...
| Geometry
| Surface >
[Copy...
| Geometry
| Surface >
[Copy...
| Geometry
| Surface >
|By Coords...
| Geometry
| Surface >
Holes >
Create

Modelling

Feature Geometry

J De-select the 3 Columns grid style check box and
enter coordinates of (0, 0), to define the lower left-
hand area of slab, and using the Tab key to move to
the next entry field enter coordinates of (6, 0), (6, 6)
and (0, 6).

e With all the coordinates entered click the OK
button to create a surface.

e Select the newly created Surface.

M Copy the selected surface with an X translation of

6.

o Click the OK button to create the new Surface.

e Use Ctrl + A keys together to select the whole
model.

M Copy the selected surfaces with a Y translation of

6. =

e Click the OK button to define two new Surfaces.

Defining a Hole in a Slab

Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.

_I Enter coordinates of (2, 2), (4, 2), (4, 4) and (2,
4) and click OK to define the extent of the hole.

e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)

e Ensure Delete geometry defining holes is
selected A new singular Surface will be created.

This new surface containing the hole can be seen / -
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[ Model Properties. ..

| Attributes
[ Mesh >
[Surface...
| Attributes
Mesh >
Line...

Simple Building Slab Design

checked by clicking in a blank part of the View Window and then re-selecting the
lower-left hand surface.

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. For this example, and to give
greater accuracy, 8 divisions per line will be used.

Note. If you are using the Teaching and Training version this default value should be
left unaltered to create a surface element mesh within the limit available. This will give
a coarser mesh and correspondingly less accurate results will be obtained

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions to
be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and dr‘o,p;

the mesh attribute Thick Plate from the
Treeview onto the selected Surfaces

In the vicinity of the lift core less elements are
required.

e Select the element type as None and enter the
Number of divisions as 4. Enter the attribute
name as Divisions=4 and the OK button

e Select the 4 lines defining the lift core and drag  |...
and drop the line mesh attribute Divisions=4

from the & Treeview onto the selected Lines.

In this manner the mesh density on slabs can be varied according to the levels of detail
required.




| Attributes
| Geometric >
| Surface. .

| Attributes

| Material >
Concrete
(Reinforced)...

| Attributes
[Support...

Modelling

Geometric Properties

Enter a thickness of 0.25. Enter the attribute name as Thickness 250mm and click
the OK button.

With the whole model selected drag and drop the geometric attribute Thickness

250mm from the &% Treeview onto the selected Surfaces. Click OK to assign to the
selected features for Analysis 1.

Geometric properties are visualised by default.

!l Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

On the RC Material dialog ensure that Country is set to Europe and Design code is
set to EN1992.

On the drop list for Concrete section select New.
On the dialog that appears select grade C40/50 and click OK.
On the RC Material dialog for the drop list for Reinforcement select New.

On the dialog that appears select grade 500B and click OK. Click OK on the RC
Material dialog.

Select the whole model and drag and drop the material attribute Matl (EN1992)
from the #® Treeview onto the selected Surfaces.

Supports

For clarity the mesh layer is not shown on these
diagrams. zz %

Select Fixed for Translation in Z and enter the

attribute name Fixed in Z and click OK. Seleciinese

Points and
assign Fixed in Z

Select the 6 points where the columns are located.

Assign the supports by dragging and dropping the

support attribute Fixed in Z from the &S l] '
Treeview and assign to Points for All analysis
loadcases by clicking the OK button. -




| Attributes

Loading...

| Attributes

Loading...

Simple Building Slab Design

El Select the isometric view
button to check that all supports
have been assigned correctly.

= b Click this part of the

status bar to view the model from
the Z direction (plan view) again.

Select the 2 Lines representing the line support
and drag and drop the support attribute Fixed in H

Z from the &% Treeview and assign to Lines for Select these 2
All analysis loadcases by clicking the OK  Linésandassign

button. Fixed in Z

Select only the top, bottom and left-hand lines T elh
defining the Ilift shaft and drag and drop the Lines:and assign
support attribute Fixed in Z from the P S Pheding
Treeview and assign to Lines for All analysis |

loadcases by clicking the OK button. —

Loading

Select Body Force and click Next.

Enter an acceleration of -9.81 in the Z direction.

Enter an attribute name of Self Weight and click the Finish button.
Select the Global Distributed radio button and click Next.

Select the Per unit area option.

Enter -3000 in the Z Direction.

Enter the attribute name as Imposed Load 3kN/m2 and click the Finish button.

Now the dead and live loading needs to be assigned.

In the Analyses (5 Treeview, right click on Loadcase 1, select the Rename option
and change the loadcase name to Permanent




| File

Running the Analysis

|Save

e With the whole model selected, assign the  poreenononnonopne
dead loading by dragging and dropping A AN AT A e AV AT
the attribute Self Weight from the ‘ by € i e
Treeview onto the selection. The loading
assignment dialog will be displayed.
Select the Single Loadcase option, the
analysis Analysis 1 and loadcase
Permanent, then click the OK button.

e With the whole model still selected, drag
and drop the dataset Imposed Load
3kN/m2 from the & Treeview onto the
selection, accepting all defaults, and
change the loadcase name to Variable
and click the OK button.

A M T gy
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Saving the model

El Save the model file.

Running the Analysis

&

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. LUSAS Solver uses
this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.

Addition files will be created in the directory where the model file resides, including:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U slab_design.mys this is the LUSAS results file which is loaded
automatically into the (X Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the




| File
[New...

| File
| Script >
Run Script...

Simple Building Slab Design

text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U slab_design_modelling.lvb carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as Slab Design

e Use the default User-defined working folder.
e Ensure an Analysis type of 2D Inplane is set.
e Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

e To recreate the model, select the file slab_design_modelling.lvb that was
downloaded and placed in a folder of your choosing.

;l Solve the model to generate the results.

Viewing the Results

Analysis loadcase results are present in the (%) Treeview and loadcase results for the
last solved loadcase are set to be active by default.

e Inthe &= Treeview, turn off the display of the Attributes layer.

e In the ‘& Treeview right-click on results loadcase Permanent and choose Set
active

e With no features selected, click the right-hand mouse button in a blank part of the

active window and select the Contours option to add the contours layer to the
Treeview.




| Attributes

Viewing the Results

Results

| Attributes

Transformation...

RC Slab/MWall

Reinforcement. ..

H Analysis: Analysis 1
L4 Select entlty Loadcase: 1:Permanent (G | Permanent
Results file: Slab_Design_Check~Analyd

FO rCE/MOment Entity: Force/Moment - Thick Plate

Component: MX (Units: N.m/m)
and results . 11 5303E3
component MX 1i.5393E3
and click OK 34.6179E3

46.1573E3

to see the 83 3350E3

e
reSUItS for Maximum 80.8931E3 at node 708 of elen
Permanent Minimum -22 9607E3 at node 27 of elel
effects in the

slab.

Wood-Armer Results

Slab design will be carried out based on the Wood-Armer moments in the slab. These
results are computed from the orientation of the reinforcement, so the reinforcement
capacities/details must be defined and assigned to the model before results can be made
available. Two attributes are available from which Wood-Armer moments can be
calculated, and these are accessed from the Attributes > Wood Armer and Attributes >
Design > RC Slab Design menu items. Since we are going to carry out slab design
calculations, we will need to create and assign to the model an RC Slab Design
attribute.

Defining a Results Transformation attribute

A results transformation attribute must be defined and assigned to all surfaces that are
to be designed in order to transform the results according to reinforcement directions.

e Choose the Global axes option.
o Enter the attribute name as Global Transformation and click OK.
e Click OK to the message that is displayed.

Assigning Results Transformation attribute

e Select the whole model and drag and drop the Results Transformation attribute
Global Transformation from the &% Treeview onto the selected Surfaces.

e Click OK to assign the attribute to surfaces.

Defining the RC Slab/Wall Reinforcement attribute

e From the Reinforcement Library select bar sizes to be Metric.




Simple Building Slab Design

e For the Top Face set the bar | ResienalRentorcemen %
SiZES as 12mm and Set the R:;::;:‘E;: 2D Grilage/Plate Ra«n{nrcememlay/mft
spacing as 100mm in both x | == e - ,4 e, Tapllaer
and Y’- R::n::m seste Eom Tz L’,( :,’ ‘
B mx Lyer] v [12om o] [1000 | mm I "( ..
e For the Bottom Face set the Basiny’ B ] [@8 Jem Top layer 2
170¢ 2¢ 12mm and cat tha | Bottom Face | 0
bar sizes as 12mm a_nd setthe = ®wree . | |
spacing as 200mm in both x Basiny B ] B0 Jem NS ;
and y’ Reinforcement cover | 0 i
. Cover Top Bottom mm ?:(S// Bottom layer 2
[] Use nominal cover in crack width calculations I e
L] Set the TOp and BOttom Nominal cover Top 200 Bottom [20.0 mm //
cover values to be 20. Oeiztien S :

Angle of bars iny’ from bars inx EXN

e Ensure the Angle of bars in

y' from bars in x is set to be
90 degrees.

Mame | Slab | B tem

Defaults oK Cancel Apply Help

e Enter the attribute name to be Slab and click OK.

Assigning the RC slab design attribute

e Select the whole model and drag and drop the RC Slab attribute Slab (T[C=20mm,
DiaX=12mm, DiaY=12mm], B[C=20mm, DiaX=12mm, DiaY=12mm)],
Skew=90) from the &% Treeview onto the selected Surfaces.

Note. Assigning the RC Slab attribute adds a new results entity Wood Armer to the
available results.

) In the ":ﬁ‘ TreevleW rlght- QOE:TCE%A:E:%&S”QN(G(;]nperkmzne?‘
click on Contours and ooy e ime,
choose Properties . 29,9753

-26.6445E3
-23.3139E3

-19.9834E3

. (==}
e Set the Entity as Wood- Bek
Armer and Component as 4 £e1zes
MX(B), click OK to close  jizimm oo stoete ooy
the dialog and plot the o
contours

Defining Load Combinations

Loadcases will be combined to provide the most adverse loading effects. Different
combination types are required in preparation for the RC Slab Design. This is achieved
using the Design Combination facility within LUSAS Modeller.
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| Design

Viewing the Results

Design

Combinations...

Combinations will be provided to EN1990:2002 for ULS Fundamental combination
(using equation 6.10), SLS Characteristic combination and SLS Quasi-permanent
combination.

Design Combinations

From the county list select Europe.

From the Design code list select EN 1990 — 2002 Buildings Recommended
Values.

For the load Permanent set the type as G | Permanent Actions
For the load Variable set the type as Qi B | Imposed: Category B — office areas
Click Next.

On the combinations options page:

Ensure that for ULS the option for Fundamental combination Eq 6.10 is selected.

Ensure that for SLS the options for Characteristic combination and Quasi-
permanent combination are selected.

Ensure that Create an envelope for each combination type is selected.
For the Add / Replace / Delete Combinations option, ensure Add is enabled.
For the Combination approach, ensure Basic Combination is selected.
Click Finish to generate the design load combinations.

From the (X! Treeview, select ULS_F_B (Min) with the right-hand mouse button
and pick the Set Active option.

In the Set Active dialog ensure Max/min primary component with coincident
effects is selected.

11
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e In the Treeview G eehin™ )
Entity: Force/Moment - Thick Plate i, e A VA VSV T o AR VA VAR T8,

right-click on Contours ~ Sompenent: MX (Units: N.mim) SVAVAVAVAYE: o AV
and choose Properties l:;g;gggggg B VAV l

-14.2691E3
0.0
14.2691E3

e Select the entity 20.5382€3
Force/Moment and Qg 718iSE
results component MX  Jemim o0 800ES 2t node 57 e
to combine, applying b
the variable factors
based on the minimum
moments in the X
direction and click the

OK button.

e Click OK to accept the warning that appears.

Caution. Whilst not a problem with this example, note that if you use smart
combinations with ‘derived components’ you may not obtain the expected results. The
online help provides details of such circumstances which you should fully understand
before using this facility. In this worked example, a linear primary component is being
used to create the smart combination from which the Wood-Armer values will be
computed. It will be necessary to carry out design checks using primary components in
both directions (X and Y) to ensure the most onerous combination is found.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and covers provided in the RC Slab
attribute.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.

12



| Design
RC Slab/\Wall
Design...

| Attributes

| Design >
RC Slab/Wall
Design...

| Design
RC Slab/Wall Design
Results...

Viewing the Results

e Ensure that Europe (Eurocode | ResiabwaliDesign X
recommended values) and EN 1992-1- = conw Europe (urocode recommended vekies) v
1:2004 are selected from the dropdown list  pesoncose [0 1852152008 .
of countries and design codes

Partial factors for materials
. . Concrete (yc)
o Accept all other settings and click OK. Reifrcig s (1)
Coefficient for long term effects for concrete
o
Defaults 0K Cancel Help

RC Slab/Wall Design Attribute

e On the General tab select the design calculation method as Bending and in-plane
(Sandwich model / Principal stresses) and click OK to add the design attribute to

the A Treeview.

o In the & Treeview right-click on results loadcase Permanent and choose Set
active

e Select the whole model and drag and drop the design attribute Desl from the &
Treeview onto the selected Surfaces.

Note. The Permanent loadcase was set active because a design attribute must be added
to a loadcase and not a combination.

Note. Whilst only the General tab was visited for this example, it is possible to modify
Shear, Min/Max reinforcement, SLS & Creep properties on the other tabs of this
dialog.

Note. For 2D plate models the design calculations options are set to bending only. For
a 3D model comprising shell elements, slab design can be carried out considering in-
plane effects as well as bending.

Adding RC Slab/Wall Design Results

On this dialog, selections can be made to specify which parts of a model should be

checked for which load groups. From the resulting entry in the (X Treeview the design
check results can be viewed, and tables of results can be obtained.
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In the Extent panel, select All members. RC Slab/Wall Design Results (EN 1992-1-1:2004) b
A . Extent
In the Design check locations panel ensure | @ ai members

that Averaged nodal is selected. O Visible members

O Group None
In the Load Groups panel press the Select | O Reinforcementattibute None
button for ULS. O Surfaces 1741

Design check locations

On the Select Loadcases dialog presented,
select ULS F B (Max) and ULS F B
(Min) and add to the Included list. Click = =&

Averaged nodal ~

ULS (2 loadcases selected) Select..
O K SLS - characteristic (2 loadcases selected) Select..
|ﬂ the Load GI’OLIpS panel press the Se|eCt SLS - guasi-permanent (2 loadcases selected) Select..
button for SLS — characteristic. Design check name Lozd group

ULS (B1862) uLs >
On the Select Loadcases dialog presented Minmax reinorcement ~
Select SLS C B (Max) and SLS C B SLS (erack control) check (7.2.4) 5LS - quasipam... |~
(Min) and add to the Included list. Click LS sresslimts 09 S5 charsoe -

Min reinfarcement (7.3.2) 5LS - charactenistic |~

OK.

Advanced options
In the Load Groups panel press the Select
button for SLS — quasi-permanent. Neme | RC Slab/wal Design 1 <] E ew

On the Select Loadcases dialog presented oI Concel Aeply fislp)
select add SLS QP_B (Max) and
SLS QP_B (Min) and add to the Included list. Click OK.

On the RC Slab/Wall Design Results dialog accept the default name of RC
Slab/Wall Design 1 and click OK to finish.

An RC Slab/Wall Design loadcase entry &5 named RC Slab/Wall Design 1 will be
added inside a Post processing folder in the (5 Treeview,

Viewing the Results

In the ™= treeview right-click on the loadcase RC Slab/Wall Design 1 and select
Set Active.

In the =¥ Treeview double-click on the Contours entry to edit the properties.

Select OK on the warning dialog that appears.

14



Viewing the Results

o Ensure that Entity £ & s o
is Set tO RC Component: Util(Max)
1.03627

Slab/Wall - EN .
1992-1-1:2004 570881
and component set iasoe

. 518135
to UtII(MaX) and gimum 5.38596 at node 708 of eleme

H Minimum 0.722754 at node 1 of elements
click OK.

It can be seen that the
maximum utilisation
is 5.386. This will be
investigated further.

o In the ‘2 treeview right-click on the loadcase RC Slab/Wall Design 1 and select
Show Results

e On the Summary tab click the Util(Max) label at the top of the last column twice
to sort by utilisation value in descending value.

RC Slab/Wall Design Results (EN 1592-1-1:2004) [m] x
SectionlD: | Al ~ SurfacelD: | Al hd Loadcase: |n/fa Face/Direction: n/a lelp
Detailed results for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary Enveloped results  Section defintions  ULS (6.1 & 6.2) Min-max reinforcement  SLS (crack cortrol) check (7.3.4)  SLS stress limits (7.2)  Min reinforcement (7.3.2)

Section Surface Element Mode LKI{ULS) Util{Asmin Asmax) UICC) LHiI{SLS.5) UHil{ASCC) Util{Max) ~
. — —— L — —— |
1 3 351 708 5.386 0723 1.952 0.306 5.386 I
1 2 304 708 5377 0723 2.056 2651 0.306 5377 I
1 2 323 708 5377 0723 2.056 2651 0.306 5377 I
1 4 334 708 5.345 0723 1.945 2.588 0.306 5.345 I
1 4 354 708 5345 0.723 1.945 2.588 0.306 5.345 I
1 1 306 708 4912 0.723 1.932 2.465 0.306 4912 I
1 1 328 708 4912 0723 1.932 2465 0.306 4912 I
1 A a5 T4 4277 07 1019 1001 nam 1277 |

From the summary table it can be seen that:
e The maximum utilisations are due to the Util(ULS) check.
e The Util(CC) and Util(SLS,S) checks also have utilisations greater than 1.0.

These results are to be investigated further by selecting the appropriate tabs.

Viewing detailed results for a slab location

Util(ULS) Check results

e On the main RC Slab/Wall Desigh Results summary table select the ULS (6.1 &
6.2) tab.

e Expand the width of the table and sort the Util(Max) column in descending order.

It can be seen that the peak values are due to the shear check Util(VRdc).

15
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RC Slab/Wall Design Results (EN 1992-1-1:2004) o x
SectionlD: | Al ~ SurfacelD: | Al ha Loadcase: Al v Face/Direction: | Al ~ Help.
Detailed rasults for selected row. Display only results for selected surfaces Select surfaces in model Select alements in model
Summary Section defintions  ULS (6.1 86.2) Min-max reinforcement  SLS (crack control) check (7.3.4)  5LS stresa imits (7.2)  Min rein 732
Seton | Swlee | Bmen | ok toasoie T v P
| s B s DU Ess | bmam | oo oo o . a
1 3 3 708 9ULS_F_B-5x Bottomx 0.000 0.000 0.981
| s = s U my | Bwem | oo oo o
1 3 351 708 10:ULS_F_B - Mxy TopX 1.749 0232 0473
| s a s S8y Ty s oz oin
1 3 351 708 9:ULS_F_B - My TopX 1749 02312 0.473
| 5 = s CUSr | B | 000 oo o
1 3 351 708 10:ULS_F_B - Mey TepY 1.806 0.245 0473 5.386 - - 5.386 ~

Util(CC) check results

e On the main RC Slab/Wall Design Results summary table select the SLS (crack
control) check (7.3.4) tab.

e Sort the Util(CW) column in descending order.

RC Slab/Wall Design Results (EN 1992-1-1:2004) =] x
SectionlD: [Al - SurfacelD: | Al v Loadcase: |Al - Face/Direction: | Al ~ Help
Detailed results for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary Enveloped resuits  Section definitions LS (6.1 4 6.2} Min-max reinforcement  SLS (crack control) check (7.3.4)  5LS stresa limits (7.2)  Min reinforcement (7.3.2)

I S~ X P N T3
1 2 304 708 Sl S TopY 10,9375 861.924
1 2 323 708 TepY 109375 861.924
1 2 304 708 TopY 109375 861.924
1 2 304 708 18:5L5_QP_B - My TopY 109375 861.924
1 2 32 708 19:5L5_ QP _B - Sx TopY 109375 861.924
1 a2 08 1R:SLS QP R A, T 1051 AR1 624 >

Investigating Util(CC) results further

o Select the first row in the SLS crack control check table and then click the Detailed
results for selected row button at the top of the dialog. Double clicking the row
will also give the detailed results.

¢ In the Design Calculation Viewer select the SLS (crack control) check (7.3.4) and
scroll through the results to view data relating to the Utilisation being exceeded.
This will be highlighted by red text — there are two instances of this in this check.

From the calculations it can be seen that the utilisation exceeds 1.0 in both the x and y
directions.

e Close the Design Calculation Viewer.

Util(SLS,S) check results

e On the main RC Slab/Wall Design Results summary table select the SLS stress
limits (7.2) tab.

e Sort the Util(Max) column in descending order.

The maximum utilisation is due to the check on Util(sigmaS).
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Viewing the Results

SectonlD: [Al “] SurfacelD: |Al ~| Losdease: [A1 - FacaiDirection: [l v [ e |
| Detailed resuls for selectedrow... | | Display only results for [ inmodel |
Summary Section defintions _ ULS (6.1 4620 Mnmax reforcement _ SLS (erack controlcheck (7.34) SLS sessiimis (2.2) Min ror 732
Secton Sutoce Elemert Node Losdzoze Foce/Diecion _Eccf (GFa] __ ilagmaS)  Ubignal) _ LiMa) _ ~
1 304 708 TopY 265
1 2 e 708 14:5L5_C_B-Sy TopY 109375 2651 0.000 2651
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e Close the RC Slab/Wall Design Results.

Viewing the contour plots

The contour plots for the results of interest will now be viewed. This is best done using
the Design contours option that shows values of utilisation from 0.7 to 1.0 and above.

¢ Inthe &= Treeview double-click on the contours layer.

e Ensure the Entity is set to RC Slab/Wall — EN 1992-1-1:2004 and the component
is set to Util(Max).

e Select the Appearance tab and select the Design option. Press OK.

The contour plot is as shown below.

Loadcase: 20:RC Slab/Wall Design 1 BEN1992—1 -1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component: Util(Max)

07
B g8
09
10

Maximum 5.38596 at node 708 of element 333
Minimum 0.722754 atnode 1 of element2

Similarly the plots of interest for Util(ULS), Util(CC) and Util(SLS,S) follow:
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Util(ULS)

Loadcase: 20:RC Slab/Wall Design 1 %EN1992—1—1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component: Util(ULS) '

0.7
B gg
09
10

Maximum 5.38596 at node 708 of element 333
Minimum 0.171288 at node 6 of element 1

| NAVAVAVAVAY |2

TAVAVAVAVAV,
K

util(cC)

Loadcase: 20:RC Slab/Wall Design 1 %EN1992—1—1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component: Util(CC)

07
B og
08
10

Maximum 2.05619 at node 708 of element 304
Minimum 7.00426E-3 at node 1260 of element 586
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Util(SLS,S)

Loadcase: 20:RC Slab/Wall De5|gn 1 (OEN1992 1-1 (Europe) | Nodes)

Entity: RC Slab/Wall - EN 1992-1-1:;
Component: Util(SLS.S)

0.7
B e
0.9
1.0

Maximum 2.65072 atnode 708 of element 304
Minimum 0.0122267 atnode 1260 of element 586

Further contour plots are available which can provide additional information. For
example the plot of Util(CC) can be separated into top and bottom checks, Util(CC(T)
and Util(CC(B)) receptively as shown below.

Util(CC(T))

Loadcase: 20:RC Slab/Wall De5|gn 1 %EN1992 1-1 (Europe) | Nodes)

Entity: RC Slab/Wall - EN 1992-1-1
Component: Util(CC(T))

0.7
B g
0.9
10

Maximum 2.05619 atnode 708 of element 304
Minimum 0.0 atnode 5 of element 1
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util(CC(B))

Loadcase: 20:RC Slab/Wall DES|gn 1 (OEN1992 1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1
Component: Util(CC(B))

Maximum 1.63847 atnode 78 of element 7
Minimum 0.0 atnode 17 of element 6

From this it can be seen that the Util(CC(T)) is critical over the central column support
while Util(CC(B)) is critical in the span near the right hand edge of the slab.

Notes regarding utilisations obtained

The objective of this example is to demonstrate the use of the RC slab/wall design
facility. To this end the modelling of the structure has been somewhat simplified.

A more accurate model could be considered by the inclusion of details such as column
heads or drop panels as necessary. Also, the modelling approach could be developed to
include the columns themselves or to provide constraint equations to reflect behaviour
more accurately at the head of the column.

In addition, the plate/shell elements in LUSAS are high performance. Therefore, the
effects of stress concentration may be considerable, as is the case in this example. As
with any finite element software, engineering judgement should be applied when
analysing the results.

As a result of this there are very high utilisations at and around the support locations.
Whilst some increase to the area of reinforcement is required to particular regions the
previous comments should be noted when considering the reinforcement requirements
near the supports.
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Save the model

El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.

Element types and orientation of results

The orientation of the slab reinforcement is aligned with the results axes. In this
example thick plate elements are used whose results axes are always transformed to the
global directions.

Caution. If shell elements are used (when they may be appropriate) the results must
be transformed into a consistent direction coinciding with the intended direction of the
reinforcement. Note that by default shell results are orientated along the local element

axes.

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transform Set... button on a
results layer’s Properties dialog. Selecting Global axes will transform local element
results into the global axes system. Other options are available.

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase x, y and z (when seen) are used to denote local results or
transformed results.

Element density and results obtained

If the Teaching and Training version of LUSAS was used to carry out this example
with a reduced default mesh density of 4 divisions per line a reduced accuracy of
results will be obtained.

In general, more accurate results are obtained when using more line mesh divisions and
hence more elements when modelling slabs of this type. Care should always be taken to
use an appropriate number of elements together with a possible refinement of the mesh
in areas of interest in order to obtain the best results.
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